ITEC 715: WEEK O3 —IN-CLASS EXERCISE: CREATING AN
INSTRUCTIONAL COMIC WITH PHOTOSHOP

Here's the finished comic you will create:

Hi. I'm Tomy Michols.
In this course, you
will learn basic account-
g priv-
=%

They say money is the
root of all evil...

...But industry can't survive
without it...

individuals...

STEP 1: GET IMAGES

If you can draw (and want to), that's fine, but it's not required for this class. Instead, you can use stock
photography. All of the images in this comic came from PowerPoint's built-in clip-art repository. Other sources you
could use include iStock Photo, Getty Images, Microsoft Office Online, and Wikimedia. The slides for Week 2 list
additional image repositories, or you can do an Internet search for "royalty-free images" or "stock photography"
and you will find tons more.

STEP 2: PLAN YOUR LAYOUT

Planning your layout means deciding the sizes of your panels and your gutters. If you comic will require more than
one strip of panels, then your layout plan should also take into account which panel will be the first to start on a
new line. For multi-line comics, you usually want the second and subsequent line of panels to align both right and
left with the top line of panels, which might require a gutter size that is different on each line. Sketch it out so you
know where everything is supposed to go.

Here's the plan for this simple comic strip, as presented in class:

Size: 650 x 150 px Gutter width: 15 px \
Panel 1 height: 150 px

Panel 1 yellow caption box height: 25 px over top of Panel 1
Panel 2 height: 125 px

Panel 2 yellow caption box height: 25 px underneath Panel 2
Panel 3 height: 150 px

Panel 3 yellow caption box height: 25 px over bottom of Panel 3
Panel 4 height: 125 px

Panel 4 white word balloon height: 25 px above Panel 4

Qanel 4 word balloon funnel: Liquify brush size 17, density 50, pressure ly




STEP 3: CHECK AND RESET RESOLUTION AS-NEEDED

When you download images from some image repositories, you can choose a variety of image sizes. Sometimes
these images may also be available in a variety of resolutions. In this case, you can think of resolution as the
formula for converting the image from screen to paper: how many pixels need to be printed per inch for the image
to maintain its intended size on the printed page? Resolution is specified in units of dots-per-inch ("dpi")

Screen resolution: 72 dpi
Common print resolutions: 150 dpi, 300 dpi
You may encounter other image resolutions, but probably not as often as 72, 150, or 300 dpi.

For work intended for presentation on a computer screen, 72 dpi is the standard resolution. To make sure that all
of your images are set to 72 dpi:

1. Load the image into Photoshop
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2. Click Image=>Image Size... to see the image resolution:
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This image has a resolution of 72 dpi, which is what you want. The image for the second panel, however, has a
print resolution which you must change to 72 dpi:
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To change the resolution, click into the Resolution box and replace 150 with 72. Then click OK. Notice how the
Width and Height in the Pixel Dimensions area have changed, but the Width and Height in the Document Size
area have remained the same. The image is still 7.553 inches by 5.027 inches in size on paper, but now with
only 72 dots per inch required, fewer pixels are needed along each dimension.
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When you've set the resolution of each image, save it by clicking File > Save for Web & Devices... and then
choosing PNG-24 from the Preset dropdown:
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Finally, click Save and choose a name for the file and a location on your computer to save it.

STEP 4: CROP AND SIZE YOUR IMAGES

After setting the resolution of all your images to 72 dpi, it's time to crop and resize your images. Stock photos
come in a variety of shapes—some are tall and narrow, others are short and wide, while still others may be
perfectly square. Every panel in this comic strip needs to have the same height, namely each must be 150 pixels

tall.

When you look at the finished comic (see Page 1 of this document), you can easily get the impression that each
image fills its panel, but this is not necessarily so. Is the yellow caption box at the top of Panel 1, for example,
placed over the top of the image in Panel 1, or are the image and caption boxes adjacent with no overlap?

According to the plan (see Page 1), the caption box in Panel 1 covers over the top 25 pixels of the image in Panel 1.

That means the image needs to be resized to be 150 pixels tall.



They say money is the
root of all evil...

Caption and image overlap (caption covers top 25 pixels of image)

By contrast, in Panel 2, the image is adjacent to (the top of) the caption box and there is no overlap. Since the
caption box is 25 pixels tall, that leaves 150 — 25 = 125 pixels for the height of the image of the factory in Panel 2.
So you must resize that image to be 125 pixels tall.

Caption and image do not overlap (image is above caption)

..But industry can't survive
without it...

You need to decide in advance if elements such as captions and word balloons will cover over part of your images
or not, otherwise you won't know what size the images need to be.

To resize the image for Panel 1, click Image = Image Size and then change the Height to 150 pixels:
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Notice that when you change the height to 150 pixels, the width also changes automatically. That's because
Constrain Proportions is checked. It is very rare that you will need to uncheck this box.

To resize the image in Panel 2 to 125 pixels, use the same procedure, but enter 125 into the Width field instead of
150. Make sure Constrain Proportions is checked so that the image resizes without distorting its geometry.

Continue to resize each image according to the master layout plan. When you have all images sized appropriately,
save each image in the PNG-24 format (by clicking File = Save for Web & Devices...).

STEP 5: CREATE A GUTTER "SPACER" BOX

Recall that in the final comic, the panels are not directly adjacent to each other. Instead there is a small gutter
between them. An easy way to measure out the gutter space and to keep it consistent between each pair of panels
is to create and use a simple gutter spacer-box. This comic strip is 150 pixels tall, and according to the layout plan,
the gutter should be 15 pixels wide. To make positioning the panels easier, create a 15 by 150 pixel rectangle.
You'll use it later to place between pairs of panels to ensure that the correct amount of gutter space appears
between them.

1. Start by creating a new image with the appropriate dimensions (15 pixels wide and 150 pixels tall) by
clicking File > New...:
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Next, enter 15 into the Width field, and 150 into the Height field. Glance at the Resolution field to make sure
it is set to the standard screen resolution of 72 dpi, and make sure the Color Mode is set to RGB. "RGB" stands
for "Red Green Blue," which are the three primary colors which, when combined in various amounts, are
capable of creating any other color from their blend. However, RGB color blending only works with colored
lights, such as the light emitted by your computer screen. For pigments on paper, canvas, or other surfaces
that reflect light rather than generate it, a different color mode is more commonly used: CMYK, which stands
for "Cyan Magenta Yellow Black" (the "B" already means "Blue" in "RBG" so to avoid confusion "Black" is
represented by its last letter, "K"). If you've downloaded images intended for print applications, they may have
their color modes set to CMYK. You should change them to RGB, though. You may receive a warning that the
colors may change slightly when you convert between CMYK and RGB, but you need to do the conversion
anyway; some Photoshop filters and other special effects cannot be applied to CMYK images, and in general,
screen images should be using RGB color.

After you click OK, you should have a new, blank image canvas that is 15 x 150 pixels:
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Next, fill this image with a color that is not present (or at least, not prominent) in your panels. You want it to
stand out so you can easily discern where it ends and the panels begin. To choose a color, double-click the top
color square at the bottom of the tool panel (circled in red on the image above). A color picker dialog appears:
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You can choose a new color by clicking anywhere on the rainbow strip, and then refining your selection by
clicking in the larger color square to its left. | chose a magenta ("hot pink") as that's color that's not in any of
the panels and it stands out a lot.
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Any color that stands out will do, but if you want to exactly replicate this color, you can enter its RGB values
(242, 13, 142) into the R, G, and B fields on the Color Picker dialog.

Next, select the entire canvas in your 15 x 150 pixel image by typing control-a (on a PC) or command-a (on a
Mac) (for "select all"—just like in Microsoft Word!). A moving dashed line, called the marquee, appears
around the edges of your image:
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Now select the Marquee Tool from the tool palette and then right-click (on a PC) or control-click (on a Mac)
inside the selected image and choose Fill... from the pop-up menu:
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The Fill dialog appears:
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Click the Use dropdown and choose Foreground Color. Make sure Blending Mode is set to Normal and
Opacity is set to 100%.
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Click OK. You will see your gutter spacer turn pink:
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Save this image as a 24-bit PNG.

STEP 6: CREATE A BLANK CANVAS FOR YOUR ENTIRE COMIC STRIP

According to the master layout plan, the comic strip overall should be 650 pixels wide by 150 pixels tall. So create a
new image (File > New...) that is 650 pixels wide by 150 pixels tall:
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STEP 7: LOAD THE RESIZED IMAGE FOR EACH PANEL, AND COPY IT TO A NEW
LAYER

Now load your resized copy of the image for Panel 1 (File 2 Open...):
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Click the window containing the image to Panel 1 to select that window. Type control-a (on a PC) or command-a
(on a Mac) to select the entire image for Panel 1, and then type control-c (on a PC) or command-c (on a Mac) to
copy the image.

Next, click the window containing your blank canvas for your entire strip to select that canvas.

Click the New Layer button at the bottom of your Layers Palette to create a new layer:
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Notice how a second layer appears above the first. You should now name your layers. The bottom layer is just the
blank background for your strip. Call it"Background." The second layer will contain the image for Panel 1. Name it
"Panel 1 Image." You can rename the layers by double-clicking into the current names on the Layers Palette and
then typing new names to replace the old ones. It is a best practice to always name your layers!

15



% Fle Edit Image Llayer Select Fiter  Analysis 3D Wiew  Window Hep | [&r > toow v WE~ =~ || DESIGN  PAINTING 3% ‘ O i~ [=o[E] = |
[EL P E) | Pestheri[ome 1 aniialis | Style: [omal =] st & Height ‘ Refne Edgen ‘

IA untitled-6 ® 100% (RGB/B) *

Doc: 285.6K,/0 bytes
[® |3 Panel 1 Image
[® | Background

wrE (o] Doc: 65.3K/87.9K

EBoGAR RN ACENNFAS[REH0]T

e
Bue(@[E] = |[@ste-[@][=] X | Qv [@[E] = | . = /06 J4 F

With your layers named, you can now paste the copy of the image for Panel 1 into the Panel 1 Image layer. Click
the layer name in the Layers Palette to ensure that it is selected as the target of your Paste operation, then type
control-v (on a PC) or command-v (on a Mac) to paste the copy of the image for Panel 1 into the Panel 1 Image
layer:
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Now you just need to move the image for Panel 1 all the way to the left. Click the Move tool in the tool palette to
select it, and then, while holding down the Shift key, drag the image for Panel 1 all the way to the left until its left
edge aligns with the left edge of the overall comic strip canvas. As you get near the edge, the image should snap
into place if you are using Photoshop CS5 or later:
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Next, load the image of the gutter-spacer. Create a new layer for it on your master canvas, name the layer, and
copy and paste the gutter spacer image into that layer using the same techniques as outlined above for the Panel 1
image. Then use the Move tool to drag the gutter spacer to the left until its left edge aligns with the right edge of
the Panel 1 image:
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Now repeat this procedure until you have place the image for each panel, and the image for each gutter spacer.
Make sure to use a new (named) layer for each element. When you're done, you master canvas should look like

this:
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As you place the final image, you will notice that it is slightly too wide for the remaining space. That's OK—just

move the image over so that its left edge aligns with the right edge of the third gutter-spacer and allow its right

edge to fall off the right edge of the master canvas.

STEP 8: ADD CAPTION BOXES

The next step is to add caption boxes to each of the first three panels. (The final panel doesn't have a caption box;

it has a word balloon, and we'll cover how to create that later).

To add a caption box, start by selecting an appropriate yellow color. It's not a requirement that your comic use a

yellow background for caption boxes; it's just that yellow caption boxes are traditional and are especially prevalent
in older comics, for example, this panel from Amazing Spider-Man #46 from 1967:

AND THEN, EXACTLY SIXTY SILENT
GECONDS LATER »-- =
UH OHS my.

Double click the foreground color box at the bottom of the tool panel and choose a suitable
yellow color. | entered ffffO0 in the # box at the bottom of the Color Picker dialog. This color
code consists of six hexadecimal digits. "Hexadecimal" means these numbers are encoded in
base-16, rather than our usual base-10 number system. In base-10, we have ten symbols for
digits: 0,1, 2,3,4,5, 6,7, 8,and 9. In base-16, we need sixteen symbols. Since our normal
counting system only has 10, we have to supplement those ten with an additional 6, and by
tradition, we use first six letters of the alphabet for this purpose. In base-16, we count 0, 1,
2,3,4,5,6,7,8,9,A,B,C,D,E, F, 10, 11, 12,13, 14, 15, 16,17, 18, 19, 1A, 1B, 1C, 1D, 1E,
1F, 20, and so on.
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In reading the six digit hexadecimal color code, you can group the digits in to three sets of two. Each pair of digits
represents how much of a particular primary color should be included in the mix to achieve your desired color. The
first two digits specify how much red is in the final color. The second two digits specify how much green is in the
color. And the last two digits specify how much blue is in the color. The order is red, green, blue—same as the
acronym for the color mode you should use for all work intended for display onscreen: RGB.

In this case, | chose #ffff00 (the "#" in front of the number signifies that the number is expressed in base-16). That
means the final color should have the maximum amount of red ("ff" is the biggest 2-digit number that can be
expressed in base-16), the maximum amount of green, and no blue. When you mix red and green light, you get
yellow, so this works well for our purposes here.

If you know how to decode the hexadecimal color codes, entering color codes directly can sometimes be easier
than hunting down the right one from the rainbow strip. If you want black, for example, that's #000000 (no red,
not green, and no blue—so, in other words, no light at all; hence: black). If you want white, that's #ffffff. Similarly,
pure red is #ff0000. Pure green is #00ff00. And pure blue is #0000ff.
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With the yellow color set as your foreground color, your next step is to create a new layer to contain the caption
box for Panel 1:
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With the new layer selected in the layer palette, go back to the tool palette and select the maiquee tool:

When you select the marquee tool, its settings appear along the top edge of your Photoshop window. Click
the Style setting to open the drop-down, and then choose Fixed Size:
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Recall from our layout plan that the caption box in Panel 1 needs to be 150 pixels wide by 25 pixels tall. Enter these
values into the Width and Height setting for the Marquee tool:
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Then click the money pile image (making sure your Panel 1 Caption Box layer is selected in the layer palette). You
will see the marquee of the specified size appear immediately. Leave the mouse button pressed, and drag the

marquee selection to the correct place (the upper edge of the Panel 1 image):

Jrarmal L | wus |

5‘ el 1 Caption Box, RGB/8) * Lock: [ o +b @ Fill: [ 10035 [* ]
,

“ [® 3 Panel 4Image

? |§ [ Gutter Spacer 3

" |§ [ Panel 2 Image

&‘ |§ [T Gutter Spacer 2

ZJ‘ [® =0 panel 2 Tmage

.\‘ [® 3 sutter spacer 1

E |§ E—1 Panel 1 Image

T‘ [® |=2 Background

Now, with the Marquee tool still selected, right-click (on a PC) or control-click (on a Mac) inside the selected area
and choose Fill...

From the Fill dialog, set the Use field to foreground color. Then click OK. Your caption box should now be yellow:
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Type control-d (on a PC) or command-d (on a Mac) to deselect the selection. Then repeat the whole caption box
creation process to create the yellow caption boxes for Panels 2 and 3.

STEP 9: ADD WORD BALLOON

We're going to create the word balloon out of two separate pieces—a basic white rectangle that will become the
main part of the word balloon, and the triangular funnel that points to the speaker's mouth.

The rectangular portion of the word balloon is simple: you can create it the same way you create caption boxes.
Just fill the word balloon rectangle with white instead of yellow:
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To create the funnel, we'll use the Pen tool. First, create a new layer for the funnel. Then, select the Pen tool from
the tool palette, and with it, click the three points of a triangle, with two points inside the white word-balloon

rectangle, and one point near "Tony Nichols" mouth. You will actually click four times because after you click the
third corner of the triangle, you need to click the first corner again in order to close the path you are creating with

the Pen tool. When you're done, your screen should look something like this:
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Next, select the Marquee tool from the tool palette, and then click the Paths tab that's located near the top of
your Layers palette (it's two tabs over from the Layers tab on my screen):

23




Shylet IFixgdSize .I wiidth: | 117 pe | &= Height:lzsm | Refine Edge.., |

F=l=

Feather: [0 px I~ Anti-alias

. comicl.psd @ 100% (Panel 4 Word Balloon funnel, RGB/8) *

IR ACSENNFAK[N RO

Move your mouse pointer over the blue-highlighted Work Path entry in the Paths palette and right-click (on a PC)
or control-click (on a Mac) to bring up a pop-up menu. From that menu, select Make Selection... A Make Selection

dialog appears:
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Cancel |
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= New Selection

 Add to Selection
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If your selections look like the above, you can accept them all by clicking OK. You've now converted the path that
you created with the Pen tool into a selection just as if you'd made it with the Marquee tool. You should now have
the dashed-line marquee selection around the triangular word-balloon funnel:
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Now you can right-click (on a PC) or command-click (on a Mac) inside the selected triangular funnel area and
choose Fill... from the pop-up menu. Fill the triangle with White. Click control-d (on a PC) or command-d (on a
Mac) to deselect the selected region. And also click the Layers tab to display your layers again. Your screen should
now look like this:
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STEP 10: HIDE GUTTER SPACERS

You can easily hide the hot-pink gutter spacer boxes from your comic strip by clicking the eyeball icon in front of
each gutter spacer layer in the Layers palette. Here's how my screen looked after | clicked the eyeball icons in front
of the Gutter Spacer 1 and Gutter Spacer 2 layers:
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The white and grey checkerboard pattern that appears between Panel 1 and Panel 2, and between Panel 2 and
Panel 3 simply indicate that those regions are transparent. When you save the file, the checkerboard pattern won't
be in your saved image.

STEP 11: CREATING BORDERS

Creating borders is a very similar process to filling in selected regions with color. The basic strategy is to use the
Marquee tool to select the region that you want to place a border around, but instead of right-clicking and
choosing Fill... from the pop-up menu, choose Stroke... from the pop-up menu instead.
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The hardest part of putting borders around your comic strip elements is selecting the right regions. Fortunately,
there are some tricks you can use that will help you.

One of the most important "tricks" for selecting is to control-click (on a PC) or command-click (on a Mac) with your
mouse pointer hovering over the little layer-thumbnail in the Layers palette:
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Notice how when you control-click/command-click on the thumbnail for the Panel 1 Image layer, the Panel 1
image gets selected. Whenever you control-click/command-click a thumbnail in the Layers palette, everything on
that layer gets selected. We will use this trick later to select the complex shape of the word balloon. But for now,
we have the first panel selected, so we are ready to put a border around it.

Create and name a new layer to contain the border for Panel 1. Then, with the Marquee tool selected, right-click
(on a PC) or control-click (on a Mac) while your mouse pointer is inside the selected region of Panel 1. From the
pop-up menu, choose Stroke...
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ekt | I Cancel
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— Blending

Mode: | Mormal A
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This Stroke dialog appears. Change the color to Black by clicking the yellow Color rectangle, and then entering
000000 into the hexadecimal # field at the bottom of the Color Picker dialog and clicking OK:
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™ Preserve Transparency

The Stroke dialog has three sections: Stroke, Location, and Blending. In the Stroke section, you can choose the
width of the stroke—that is, the width of the line that will act as the border around the selected region—and the
color of the stroke, which we've already set to black. For this comic, we'll use a 2-pixel wide border. So enter 2 px
into the Width field:

sroke Ed
Stroke
Width: |2 px Cancel
Colar: -

Location
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Blending
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Opacity: | 100 Yo

™ Preserve Transparency

In the Location selection, you must decide if you want the border to hug the inside edge of the selected region,
straddle the edge of the selected region, or hug the outside edge of the selected region. With our 2-pixel stroke,
for example, if we select Inside, the stroke will cover the two pixels along the edges of the Panel 1 image.

If we choose, Center, one of the pixels of our border will cover the outermost pixel of the Panel 1 image, and the
other will try to paint itself around just outside the selected border. Unfortunately, selecting Center in this case
would cause half the width of the stroke to fall off the edge of the canvas on the top, left, and bottom sides. On
the right side, the second pixel of our 2-pixel border would cover the line of leftmost pixels along the left edge of
our gutter between Panels 1 and 2.

Similarly, if we chose Outside, both pixels of our 2-pixel border would fall off the edge of the canvas on three sides,
and would eat into our gutter space on the fourth side. That's not what we want.

So in this case, we must choose Inside to avoid having parts of the stroke disappear off the edges of the canvas.

When you've made all your choices on this dialog box, click OK to create your stroke and then click control-d (on a
PC) or command-d (on a Mac) to deselect the selection. Your screen should look like this:
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Now repeat this general procedure to place a similar stroke around the Panel 1 caption box. On three sides, its
stroke will overwrite the panel's overall border, but since the border around the caption box and the border
around the panel itself are both 2-pixels wide and are both black, it won't matter that one overwrites some of the
other:
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The situation with Panel 2 is bit more complicated because in that panel, the image and caption box do not
overlap. Rather, they are adjacent to one another. Therefore, if we put a 2-pixel border around the inside of each
one, we will end up with a 4-pixel-wide line between the bottom of the image and the top of the caption box. But
that's OK because we will simply delete the border along the lower edge of the image after we've created the
stroke.

Start by creating and naming a new layer for the border around the image in Panel 2. Then, control-click (on a PC)
or command-click (on a Mac) the thumbnail for the Panel 2 image in its layer in the Layers palette. This selects the
contents of that layer. Since that layer contains only the image for Panel 2, the result is that the Panel 2 image is
selected, as evidenced by the dashed marquee line around it:
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Next, with the Marquee tool selected, right-click (on a PC) or control-click (on a Mac) inside the selected region,
and choose Stroke... from the pop-up menu. Select a width of 2 px, the color Black, and a location of Inside from
the Stroke dialog and then click OK to create the stroke. Repeat this procedure to put a similar stroke around the
Panel 2 caption box. After you type control-d (on a PC) or command-d (on a Mac) to deselect, your screen should
look like this:
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It may be hard to see in the image above, but the line between the image and the caption box in Panel 2 is too
thick. It's 4 pixels wide, because there is a 2-pixel line along the inside top edge of the caption box, and another 2-
pixel line along the inside bottom edge of the image. To keep all the borders 2 pixels wide throughout, we need to
remove the 2-pixel wide line at the bottom of the image.

The image in Panel 2 is 188 pixels wide, and therefore, the border at its bottom is 2 pixels by 188 pixels. However,
we want to keep the 2 pixels at either end because those pixels are part of the border along the image's left and
right sides. We only want to remove the center 184 pixel segment of the line.

Click the Panel 2 Image Border layer in the Layers palette to select it. Then, click the Marquee tool in the Tools
palette to select it. In the Marquee tool's settings at the top of your Photoshop screen, select Fixed Size from the
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drop-down menu and then enter 184 for the Width and 2 for the Height. Click Panel 2 and drag the fixed-size
selection until it exactly covers the center portion of the image's bottom border (you may want to zoom in for fine
detailed work like this—remember control-plus and control-minus (on a PC) or command-plus and command-
minus (on a Mac) allow you to zoom in and out, respectively):
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With the middle segment of the bottom border selected with the marquee, and the Panel 2 Image Border layer
selected in the Layers palette, type control-x (on a PC) or command-x (on a Mac) to cut the selected pixels out of
the selected layer.
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Our border is now fixed.

Putting the border around the image and caption box in Panel 3 is just like putting the border around the image
and caption box in Panel 1.

A trickier challenge is to put a border around the word balloon. Because it has two components, each on a
separate layer, we can't simply control-click (on a PC) or command-click (on a Mac) the appropriate layer. We can't
put strokes around each component, either, because we would end up with internal lines we don't want. We could
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delete those lines, much as we did with the center portion of the lower border around the image in Panel 2.
However, there is a better way.

Whenever you have two layers that are adjacent to each other in the Layers palette, you can combine them into
one layer by using the following procedure:

1. Click the top layer of the pair in the Layers palette to select it.
2. Type control-e (on a PC) or command-e (on a Mac) to combine the selected layer with the layer below it.
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After you combine layers, you lose the ability to select them individually, so generally you want to use this trick
sparingly. However, in the case of the word balloon's two layers, they are essentially two parts of the same thing
(the Word balloon), so combining them makes some sense.

With the two layers combined, we can now control-click (on a PC) or command-click (on a Mac) to select the
newly-combined shape of the word balloon plus funnel:
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Now, with the full word balloon selected, you can create and name a new layer to hold the word-balloon border,
and the right-click (on a PC) or control-click (on a Mac) to begin the stroke process. When you have completed it,
your screen should look like:
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STEP 12: ADD TEXT

Next, you need to add the text to your caption boxes and word balloon. Do this with the Text tool:
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With the Text tool selected, you can choose your font face, font weight (e.g., bold, italic, or regular), font size, text
alignment (e.g. left justified, center justified, or right justified), and the font color in the tool settings strip across
the top of your Photoshop window.

Because our comic is relatively small, we will have to use a fairly small font size. I've chosen a 9 point Comic Sans
MS font, which is designed to look a bit like a comic book font. Although it's traditional in older comics to use only
upper-case letters, modern comics allow lower-case letters as well, so we'll use mixed-case in this example comic.
For your comic, | recommend mixed-case as well, since it is generally easier to read.

With the Text tool selected, drag your I-beam cursor across the general region where you want your text to
appear, and then type your text. You can make fine adjustments in the text's position by clicking the Move tool
and either dragging the text layer around with your mouse, or nudging it into place with the arrow keys on your
keyboard.

In your own comic, please make sure the font is actually large enough to be readable, and that there is at least a
small margin around the text in all directions. Don't let it run into the edges or borders, as that makes it look too
cramped.

Your first-draft comic should look something like this:
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At this point, we can see that the caption box in Panel 1 should probably be made a bit taller, and the word balloon
in Panel 4 should likewise be made taller because there isn't enough room for the text, even after shortening the
prose as much as possible.

To make the caption box bigger, you just have to go back to the caption box layer and, using the Marquee tool,
select a taller rectangle—maybe 35 pixels instead of 25 tall. Similarly, in panel 4, you may need to go back to the
word balloon layer and make the rectangle 35 pixels tall, too.

| leave those tasks to you. All the procedures you need are already documented in this paper.

STEP 13: SAVING AND EXPORTING

After you've made your final tweaks and are satisfied with the comic, save your work by clicking File > Save As...

The Save As dialog looks different on Windows and Mac OS, but in either case, you want to give your file a
meaningful name, and save it in the native Photoshop (*.PSD, *.PPD) format. Give it a name that ends in ".psd".

The *.psd file is your "source" file—it retains all the layer information, so you can go back and edit any individual
layer should you find you need to make changes (e.g., if you discover a typo, or want to reposition an element).
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However, *.psd files are not good for importing into your e-learning course. PowerPoint won't accept an image in
the Photoshop native format. So in addition to saving your work as a *.psd file, you should also export a copy in
the PNG format. PNG-formatted images are what you will import into PowerPoint and deliver in your e-learning
course.

To export your image as a PNG, click File = Save for Web & Devices... You'll see the following dialog:
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From the Preset drop-down, choose PNG-24. Since we have transparent regions (our gutters), make sure the
Transparency checkbox is checked to preserve those transparencies in the PNG. If your course has a background
color that is not white, you can change the Matte drop-down to match the background color in your course. That
will affect the way the colors around the edges of the transparent regions get blended with the background that
shows through the transparent regions of the image. If your course has a white background, you can leave the
Matte field set to its default (or to White) on this dialog.

When you're done, click Save and you will be asked to choose a location and name to save your file.

Please bring both the *.psd and *.png files with you next week to class; you will turn both version in by uploading
them to the ITEC 715 Student Work folder on the network shared drive during class. | will explain in detail how to
do this in class, so just make sure you have the files ready.

Questions or comments? Email me at rayc@sfsu.edu.
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